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SUMMARY: 18 

Physical modeling of microscopic systems helps obtain insights that are difficult to gain by other 19 

means. To facilitate the construction of physical molecular models, we demonstrate how 3D 20 

printing can be used to assemble functional macroscopic models that capture qualities of 21 

molecular systems in a tactile way. 22 

 23 

ABSTRACT: 24 

With the growth in accessibility of 3D printing, there has been a growing application of and 25 

interest in additive manufacturing processes in chemical laboratories and chemical education. 26 

Building on the long and successful history of physical modeling of molecular systems, we present 27 

select models along with a protocol to facilitate 3D printing of molecular structures that are able 28 

to do more than represent shape and connectivity. Models assembled as described incorporate 29 

dynamic aspects and degrees of freedom into saturated hydrocarbon structures. As a 30 

representative example, cyclohexane was assembled from parts printed and finished using 31 

different thermoplastics, and the resulting models retain their functionality at a variety of scales. 32 

The resulting structures show configurational space accessibility consistent with calculations and 33 

literature, and versions of these structures can be used as aids to illustrate concepts that are 34 

difficult to convey in other ways. This exercise enables us to evaluate successful printing 35 

protocols, make practical recommendations for assembly, and outline design principles for 36 

physical modeling of molecular systems. The provided structures, procedures, and results 37 

provide a foundation for individual manufacture and exploration of molecular structure and 38 

dynamics with 3D printing. 39 

 40 

INTRODUCTION:  41 

Molecular structure building has long been a critical aspect for discovery and validation of our 42 

understanding of the shape of and interactions between molecules. Physical model building was 43 

a motivating aspect in the determination of the α-helix structure in proteins by Pauling et al.1, 44 
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the primary clathrate hydrate structures of water2,3, and the double-helix structure of DNA by 45 

Watson and Crick4. In James Watson's published account of the DNA structure, he details many 46 

of the struggles faced in such model building, such as wrapping a copper wire around model 47 

carbon atoms to make phosphorus atoms, precariously delicate suspensions of atoms, and 48 

making cardboard cutouts of bases while waiting on tin cutouts from the machine shop5. Such 49 

struggles in model building have largely been remedied with computational modeling 50 

augmenting or entirely supplanting physical approaches, though physical models remain an 51 

essential aspect in chemical education and experimentation6-9. 52 

 53 

Since around 2010, 3D printing has seen a significant growth in adoption as a tool for creative 54 

design and manufacturing. This growth has been driven by competition and availability of a 55 

variety of Fused-Deposition Modeling (FDM) printers from a series of new companies focused on 56 

broad commercialization of the technology. With the growing accessibility, there has been a 57 

concurrent growth in application of these technologies in chemistry education and experimental 58 

laboratory settings10-21. During this time period, both commercial and open community 59 

repositories for 3D models, such as the NIH 3D Print Exchange22, have made model systems for 60 

3D printing more accessible, though many of these models tend to be centered on specific target 61 

molecules and provide simple static structures with an emphasis on bond connectivity and type. 62 

More general atomic and molecular groups can enable more creative constructions12,23, and 63 

there is a need for models that can enable general structure creation with tactile, dynamic, and 64 

force sensitive feedback for molecular structures. 65 

 66 

Here, we present molecular model structure components that can be readily printed and 67 

assembled to form dynamic molecular models of saturated hydrocarbons. The component 68 

structures are part of a wider kit we have developed for extension and outreach activities for our 69 

laboratory and university. The parts provided have been engineered to be printable with a variety 70 

of polymer filament types on commodity FDM 3D printers. We present model results using 71 

different polymers and finishing techniques from both single and dual extruder FDM printers. 72 

These components are scalable, enabling model manufacturing suitable for both personal 73 

investigation and demonstration in larger lecture settings. 74 

 75 

The primary aim of this report is to aid other researchers and educators in translating chemical 76 

structure details and knowledge in more physical ways with 3D printing. To this end, we highlight 77 

an example application by assembling and manipulating cyclohexane at different scales. Six-78 

member ring system conformations are a core topic in introductory Organic Chemistry courses24, 79 

and these conformers are a factor in the reactivity of ring and sugar structures25-27. The printed 80 

models flexibly adopt the key ring conformers24, and the force needed for ring interconversion 81 

pathways can be directly explored and qualitatively evaluated by hand. 82 

 83 

PROTOCOL: 84 

 85 

1. Preparation of model files for 3D printing 86 

 87 



   

 

 

NOTE: The large number of 3D printers and free and commercial printing software make exact 88 

directions beyond the scope of this article. General protocol process and recommendations are 89 

provided here, with specific considerations given for representative models shown with the listed 90 

software and 3D printers (see Table of Materials). Dedicated manufacturer directions specific to 91 

a reader's printer and slicing software combination take precedence over the provided 92 

recommendations.  93 

 94 

1.1. Download the supplementary stereolithography (.stl) files associated with this article 95 

(Supplementary Files S1‒S5). Upload these files to the computer with the slicer program. 96 

  97 

1.2. Import one of the C_atom_sp3, H_atom, or C-C_bond files into the slicer program. Use 98 

millimeter format for the units if an option is available. In the software, either click the Import 99 

button of the Models panel of the main window or select the Import Models command under 100 

the File pulldown menu. Select the appropriate model file from the resulting file browser.  101 

 102 

1.2.1. Import both H_atom_dual_bottom and H_atom_dual_top files for dual extruder prints of 103 

the hydrogen atom. Align, group, and assign the component models to the relevant extruder 104 

based on the target filament color.  105 

 106 

1.3. Scale the imported model to the desired size. For this, double-click either the graphical 107 

model in the main display or the listed model in the Models panel of the main window. This 108 

action opens a model editing panel that enables translation, rotation, and scaling of the target 109 

model. Representative models are presented for 50%, 100%, 200%, and 320% scale for all 110 

interconnecting parts. 111 

 112 

1.3.1. Activate support structures for C_atom_sp3 models with scales greater than 100%. 113 

Support structures can be used but are generally not necessary for all other models. 114 

 115 

1.3.2. Activate a raft or brim structure for 100% and smaller scale models. Such structures should 116 

not be necessary for most larger models as the flat base will have sufficient contact with the bed 117 

surface to remain fixed in place. Rafts help provide a well-adhered first layer for a 3D print, so if 118 

there are any difficulties in the stability of the first printed layer at any scale, activating a raft 119 

structure could lead to more successful prints at the expense of the material needed for the raft 120 

structure. 121 

 122 

1.4. Duplicate models to generate an array of models as desired by selecting the Duplicate 123 

Models option from the Edit menu and entering the number of model parts in the resulting dialog 124 

box. Arrange the model(s) near the center of the build platform by clicking the Center and 125 

Arrange button in the Models panel of the main window, or by selecting the Center and Arrange 126 

option under the Edit pulldown menu.  127 

 128 

NOTE: See Figure 1 for an example arrangement of six C_atom_sp3 models printed with 129 

polylactic acid (PLA). It is safest to print a single part at a time, though printing multiple small 130 

parts of the same color is usually more time-efficient. The print quality of parts in arrays is often 131 



   

 

 

lower because of the need for more filament retraction points between models. Array prints of 132 

models also have an increased likelihood of failure as one fallen part during printing can interfere 133 

with the printing of other parts. 134 

 135 

[Place Figure 1 here] 136 

 137 

1.5. Set the appropriate model processing settings for target prints using Add or Edit Process 138 

Settings from the Processes panel of the main window.  139 

 140 

NOTE: The software used has selectable default processing settings for PLA, ABS, and other 141 

available thermoplastics when adding a new process or editing a process by respectively clicking 142 

the Add or the Edit Process Settings from the Processes panel of the main window. Specific 143 

adjustments and rationale for the provided molecular model parts follow.  144 

 145 

1.5.1. Set the model infill value between 15% and 25%. This will use less filament and result in 146 

lighter parts, but the final assembled structures will be strong enough to survive physical 147 

manipulation. 148 

 149 

1.5.2. Use 100% infill settings for the connector regions of C-C_bond and H_atom model parts if 150 

possible or as needed to increase the durability of connector tabs. 151 

 152 

1.5.3. Choose a print layer thickness of 0.2 mm or smaller to maintain print detail.  153 

 154 

1.5.4. Set the First Layer Speed to a value between 25 and 50% in the Layer tab of the process 155 

settings. A slowly printed first layer will improve adhesion to the print bed and will result in more 156 

successful overall 3D prints. 157 

 158 

1.5.5. Set the printer extruder and printer bed temperatures to values recommended for the 159 

chosen printer filament material. The provided temperatures are starting point 160 

recommendations.  161 

 162 

1.5.6. For C_atom_sp3 model parts, use two Outline/Perimeter Shells with an "Outside-In" 163 

Outline Direction to minimize print distortion at the bottom of the sphere. These options are 164 

available from the Layer tab of the Process settings window. For all other parts, the "Inside-Out" 165 

Outline Direction is recommended for a cleaner surface finish.  166 

 167 

1.5.6.1. For PLA, set Extruder = 215 °C; Bed = No heating. 168 

 169 

1.5.6.2. For polyethylene terephthalate glycol-modified (PETG) set Extruder = 235 °C, and Bed = 170 

80 °C.  171 

 172 

1.5.6.3. For acrylonitrile butadiene styrene (ABS) set Extruder = 245 °C and Bed = 110 °C. 173 

 174 



   

 

 

1.5.7. If performing a dual extruder print of the aligned H_atom_dual_bottom and 175 

H_atom_dual_top models, optionally turn on an ooze shield option. The slicer will then generate 176 

a thin wall geometry around the model that will catch any dripping polymer from the inactive, 177 

yet still hot, extruder tip. 178 

 179 

1.6. Slice the model into print layers to generate a G-Code toolpath. Click the Prepare to Print! 180 

button on the main window, or select the Prepare to Print option under the Edit pulldown menu. 181 

 182 

2. Preparation of the printer for printing of parts 183 

 184 

2.1. Coat the surface of the printer bed with blue painter's tape for unheated beds. Coat the 185 

surface of the printer bed with blue painter's tape and an underlayer of polyimide tape for heated 186 

beds.  187 

 188 

2.2. Apply a thin layer of glue stick to the blue painter's tape. Glue stick polymer will improve 189 

print adhesion to the bed surface. 190 

 191 

2.3. Place or close a ventilated enclosure over the printer bed. An enclosure minimizes air 192 

currents that can disturb print annealing. 193 

 194 

2.3.1. For PLA, open any/all ventilation ports as rapid cooling is preferred. Turn on a bed fan 195 

during printing if possible. 196 

 197 

2.3.2. For PETG, open a limited number of ventilation ports as gradual cooling is preferred. A bed 198 

fan is unnecessary during printing. 199 

 200 

2.3.3. For ABS, open a minimum number of ventilation ports as very gradual cooling is preferred. 201 

Turn off bed fans during printing. 202 

 203 

3. Finishing and assembly of model structures 204 

 205 

3.1. Remove parts from the printer bed. In the case of heated bed prints, remove parts after the 206 

bed has cooled to avoid distorting the model during separation. 207 

 208 

3.2. Remove raft or brim structures from the base of parts if used. Rub the base of the model 209 

part with medium to fine grit sandpaper to remove any remaining attached raft filaments. 210 

 211 

3.3. Sand the base of the C_atom_sp3 model parts with medium (120 grit) to very fine (320 grit) 212 

sandpaper to remove surface defects. Smooth the surface with the very fine grit sandpaper. 213 

Polish the surface to desired finish with a polishing cloth or buffer wheel at low revolution per 214 

minute setting.  215 

 216 

NOTE: For example, a Dremel tool with a 0.5-inch diameter buffer wheel set to 10,000 rpm can 217 

be used for polishing, taking care to not to overly heat the print and cause surface defects. PLA: 218 



   

 

 

Prints typically have a slightly glossy finish following printing as shown in the panels of Figure 2. 219 

This finish is marred by coarse sanding, but the glossy finish can be restored with polishing. PETG: 220 

Prints typically have a slightly glossy finish that can be sanded and restored with polishing as with 221 

PLA. ABS: Prints typically have a matte or only marginally glossy finish following printing (Figure 222 

3A). A high-gloss finish (Figure 3B) can be achieved by separately dipping the parts in an acetone 223 

bath for 1‒2 s and placing them in a ventilated area until the acetone has evaporated and the 224 

surface has solidified within typically 12‒24 h. 225 

 226 

CAUTION: Acetone is flammable and should be applied sparingly in a fume hood or very well-227 

ventilated area. ABS dissolves in acetone, so parts with layer separation defects due to poor 228 

annealing should not be treated with liquid acetone. Acetone will enter models through such 229 

defects and dissolve the model infill (Figure 3C). Polishing with acetone vapor is a slower process 230 

that will result in a similar effect, though safety precautions should be taken given the 231 

flammability of acetone. 232 

 233 

[Place Figure 2 here] 234 

[Place Figure 3 here] 235 

 236 

3.4. Insert connector ends of C-C_bond and H_atom model parts into sockets on C_atom_sp3 237 

model parts according to desired bonding topology. Squeeze model parts together until an 238 

audible click is heard. Once connected, the single bond should freely rotate about this connection 239 

without falling apart.  240 

 241 

NOTE: The connection fit is tight, so this may require significant force for models with scaling 242 

greater than 100%. The provided parts are not intended to be separated after connecting them 243 

together, but they can be separated with a very significant applied force. Rotation about a 244 

connected bond is a desired feature for the provided parts and models. Locking rotation requires 245 

an atom model (an sp2 hybridized carbon, for example) with a fixed structure in the connection 246 

socket that inserts between the spacings of the tabs on the end of the bond model.  247 

 248 

3.5. Assemble all printed parts according to the desired molecular structure. Saturate all 249 

C_atom_sp3 model parts by filling any open socket with an H_atom model part. For a ring like 250 

cyclohexane, close the ring with a C-C_bond model part between C_atom_sp3 model parts. 251 

 252 

REPRESENTATIVE RESULTS:  253 

The protocol provided covers a variety of potential options for interactive molecular model 254 

construction. As a basic and unifying example for a molecular assembly using these model parts, 255 

we have chosen to assemble interactive cyclohexane structures at a variety of scales. Figure 2 256 

shows the parts necessary for this structure: six C atoms, six C-C bonds, and twelve H atoms. 257 

These specific prints were crafted using both printers listed in the Table of Materials. The more 258 

costly dual extruder printer enables the production of dual color components; here the two-259 

colored hydrogen atom structures with the color change at the midpoint of the bond (Figure 2A). 260 

The mono-colored hydrogens in Figure 2B print in about 50‒60% less time due to the lack of an 261 

ooze shield structure and lack of polymer retractions in switching between active extruders. The 262 



   

 

 

assembled cyclohexane structures (Figure 2C) are functionally equivalent, though the dual 263 

extruder prints tend to look moderately more refined. 264 

 265 

The PLA models in Figure 2 have reasonably nice finish, that is more refined than ABS models 266 

straight off the printer (Figure 3A). Chemical treatment of ABS models with acetone gives a 267 

smooth and high gloss finish that almost gives the surface a wet look (Figure 3B). Such finishing 268 

can be troublesome, particularly if ABS models are not annealed well. Large models printed with 269 

ABS are prone to layer separation defects. When the previous layer cools before the extruder 270 

this can traverse over to lay down the next layer. It is critically important for large ABS prints that 271 

the environment around the heating bed of the printer remain at an even and warm temperature 272 

to slow down the cooling rate. If a print with a layer defect is submerged in acetone, the acetone 273 

will enter the model and dissolve the interior support structure. This will collapse the model from 274 

the inside as shown in Figure 3C. 275 

 276 

A visually distinct appearance is secondary to functionality of the model structures. The 277 

connectors were designed to enable free rotation about single bonds. To test their utility in 278 

different systems, four different sets of part sizes were printed, with the carbon atom diameter 279 

running from 17.5 mm, 35 mm, 70 mm, and 112 mm. The assembled cyclohexane structures 280 

(Figure 4) were all able to flex, distort, and adopt relevant conformers in the same manner. The 281 

smallest of these models was the most prone to print flaws, making this size potentially too small 282 

and not recommended without tweaking the relative size of the parts. One of the primary 283 

benefits to the smaller prints is the speed of printing. An array of six of the smallest carbon atoms 284 

printed in around 2 h, as compared to the 10 h required for a single carbon atom of the largest 285 

size. While slow to print, large models are potentially more effective for communication in lecture 286 

settings where it would be difficult to see the motion of a small structure from a distance. 287 

 288 

[Place Figure 4 here] 289 

 290 

The dynamic aspect is one of the key attributes that separate these structures from other 291 

printable molecular models. Since the atoms can readily rotate relative to one another, the 292 

structures can be distorted to snap into the different representative conformers of cyclohexane. 293 

Figure 5 shows the chair, boat, and the transition state structure for interconversion between 294 

their respective configuration spaces. This transition state point has four labeled carbon atoms 295 

in a nearly planar geometry24,28, the same transition state structure that one achieves doing 296 

B3LYP/6-311+G(2d,p) calculations29. Following the same transition state imaginary frequency 297 

motion, slightly twisting 2 up and 3 down will snap the model into the boat conformer landscape, 298 

while slightly twisting 2 down and 3 up will return the structure to the chair conformer. 299 

 300 

[Place Figure 5 here] 301 

 302 

The state point free energy estimates (Supplementary Table S1) from B3LYP/6-311+G(2d,p) 303 

calculations of optimized state points (Supplementary Files S6‒S9) give a gap between the twist-304 

boat and boat conformers of 0.8 kcal/mol, which is very close to thermal energy at 298.15 K. This 305 

suggests that conversion between these should sample nearly freely. The gap between the chair 306 



   

 

 

conformer and interconversion transition state is more than ten times this value, indicating that 307 

the chair should be conformationally locked in comparison. This is illustrated in Figure 6, which 308 

shows estimated average conformer energy when each carbon atom location relative the ring 309 

plane is latitudinally projected onto a sphere over the course of a gas phase molecular dynamics 310 

calculation30,31. In the chair conformer on the left, the energy is low when the carbon atoms are 311 

displaced above or below the ring plane, but it ramps up dramatically if they displace to align 312 

with the ring plane. In the boat conformer, the conformer energy is relatively low when carbons 313 

are in the ring plane (twist-boat state), and the more highly displaced boat conformer is not at a 314 

drastically higher energy. These configuration landscapes can be explored with the 3D printed 315 

cyclohexane models, with the chair conformer only being able to locally vibrate while the boat 316 

conformer can smoothly undulate from one pair of opposite carbon atoms to the next. 317 

 318 

[Place Figure 6 here] 319 

 320 

FIGURE AND TABLE LEGENDS:  321 

 322 

Figure 1: Like-colored atoms or bonds can be printed as arrays. To increase printing efficiency 323 

at a slight cost in quality, parts of like color are readily printed in arrays. Here, six PLA carbon 324 

atoms are printed together, each positioned on a small raft structure with an outlining brim 325 

structure. 326 

 327 

Figure 2: Dual extruder prints can be more visually refined. (A) Dual extruder model hydrogen 328 

atom prints are visually more cohesive than (B) all white model hydrogen atom prints. (C) When 329 

connected together to form complete cyclohexane rings, the assembled PLA models are 330 

functionally identical. 331 

 332 

Figure 3: ABS models can be chemically processed for a glossy finish. (A) ABS model prints tend 333 

to have a more diffuse or matte appearance, but (B) after chemically treating the parts with a 334 

brief dip in acetone they gain a high gloss finish. (C) If acetone enters the interior of the print 335 

through layer separation defects, the acetone will dissolve the model from the inside out, causing 336 

it to collapse. 337 

 338 

Figure 4: Models are functional at a variety of scales. To illustrate how the models can be printed 339 

for different purposes, cyclohexane models were assembled at four different scales and all retain 340 

the same functionality. The carbon atoms of the largest are larger than a softball (112 mm 341 

diameter) while the assembled cyclohexane of the smallest could fit within a softball. 342 

 343 

Figure 5: Conformers of cyclohexane are fully accessible. As the atoms can rotate about their 344 

bonds, the models can adopt the sterically locked chair and more conformationally free boat 345 

forms. The transition state between these forms involves four nearly coplanar carbon atoms in 346 

the ring. Lightly twisting 2 up with 3 down will slip the model to the boat conformer, while 347 

twisting 2 down with 3 up will return the model to the chair conformer. 348 

 349 



   

 

 

Figure 6: Model behavior matches calculations. In the chair and boat conformer states, the 350 

latitudinal displacement of carbon atoms about the ring plane over the course of a Molecular 351 

Dynamics calculation can be projected onto the surface of an enclosing sphere. While the chair 352 

form is most energetically stable, it is locked and can only interconvert to the inverted form by 353 

passing through a high energy transition state. Both calculations and printed model flexibility 354 

indicate that the boat and twist-boat conformers are separated by close to 1 kBT at 298.15 K, 355 

allowing nearly free latitudinal displacement of carbon atoms in this form. 356 

 357 

Supplementary Table S1: State point free energy estimates. 358 

 359 

DISCUSSION:  360 

The primary aim of this study is to report a protocol for the crafting of dynamic molecular models 361 

with commodity 3D printers. These printers are increasingly accessible, often even free to use in 362 

libraries, schools, and other venues. Getting started involves making choices about both the 363 

models to print and the materials to use and deciding from these options may require some 364 

inspiration regarding what creative additive manufacturing can do for research and instruction. 365 

To address these issues, we provide some practical material recommendations, suggested model 366 

parts, a 3D printing protocol, and an example application, each of which warrant further 367 

discussion. 368 

 369 

There are many choices of thermoplastic for use in 3D printing. We highlight three in the 370 

presented protocol as these three materials are currently the most widely available for do-it-371 

yourself 3D printing. The choice may depend on what material is supported by an available 3D 372 

printer, for example many open access facilities will only print with PLA because of environmental 373 

constraints. PLA is a biodegradable and compostable material that has a printing protocol with 374 

mild temperature settings. Both ABS and PETG are less environmentally friendly and not 375 

generally recyclable, though PETG is based on highly recyclable polyethylene terephthalate (PET) 376 

and may eventually see wider spread reprocessing like PET. Sustainable printing practices would 377 

involve printing few parts at a time to ensure both print quality and print success, this while using 378 

as little discarded material (support structures, rafts, ooze shields, etc.) as possible. PLA can be 379 

brittle, so if available, ABS and PETG thermoplastics can result in prints that are more 380 

mechanically resilient and have improved layer adhesion, respectively. These properties could be 381 

desirable for an interactive molecular model that will see regular manipulation in a laboratory or 382 

classroom setting. 383 

 384 

The models presented here take these considerations into account, though they are firstly 385 

engineered to work together to enable dynamic molecular model construction. At the default 386 

scale, they will assemble successfully into interactive molecular structures. They can readily be 387 

scaled up to large models, though assembly will require more force as the connection prongs are 388 

less easy to distort at larger size. In shrinking the components, a 50% reduction in size will still 389 

work with minor modifications, such as shrinking the carbon atom model to 48‒49% while 390 

keeping the bond and hydrogen atom at 50% to enable tighter connections between parts in PLA 391 

prints. Models this small are more delicate and often require raft structures to successfully print, 392 

but they are still functional as dynamic molecular models. 393 



   

 

 

 394 

The thermoplastic material and chosen models to print are the two most critical aspects of a 3D 395 

printing protocol. The chosen thermoplastic will dictate the temperature, adhesion, annealing, 396 

and finishing considerations and options. If the available 3D printer does not have a heated bed, 397 

PLA is the only one of the presented thermoplastic choices that will print parts reproducibly. 398 

While the provided parts are designed to reproducibly print with different thermoplastics and 399 

hold up to dynamic manipulation, prints will degrade with use and crack, often between print 400 

layers, when placed under increasing stress. In such situations, it is easy and relatively cost 401 

effective to print a replacement part. 402 

 403 

The dynamic functionality of molecular assemblies printed from the provided models 404 

differentiates this work from other available and 3D printable models that primarily highlight 405 

connectivity and bonding types. The dynamical aspects are presented in small part with the 406 

example cyclohexane structure. The configuration landscape of cyclohexane is directly accessible 407 

by hand using these models, and the topologies of these landscapes are in general agreement 408 

with computational investigations. Much of this comes from a respect for the specifics of 409 

molecular geometry and degrees of freedom in these physical modeling components. In Linus 410 

Pauling's commentary on their success in discovering the structure of the α-helix1, they claimed 411 

that their contemporaries faced difficulties coming from idealistic integral assumptions and 412 

adopting "...only a rough approximation to the requirements about interatomic distances, bond 413 

angles, and planarity of the conjugated amide group, as given by our investigations of simpler 414 

substances." More quantitative insight along these lines requires more specific detail than the 415 

considerations taken in building these model parts, but these models and recommendations 416 

provide a foundation for general interactive physical investigation of molecular systems. These 417 

models are an extension of 3D printable model kits we have been producing for research and 418 

outreach activities for several years prior to this report, and additional component parts that are 419 

compatible with both these models and the described protocol are available from the authors to 420 

enable more diverse bonding arrangements and dynamical action.  421 
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Name of Material/ Equipment Company Catalog Number Comments/Description

ABS: Black 1.75 mm filament spool, 1 kg MakerBot MP01969 Obtained from reseller (B&H and/or Amazon).

ABS: Dark Gray 1.75 mm filament spool, 1 kg Amazon B07T6W8TRF Obtained from reseller (B&H and/or Amazon).

ABS: White 1.75 mm filament spool, 1 kg Hatchbox B00J0H6NNM Obtained from reseller (B&H and/or Amazon).

Crown Acetone, 1 Gallon Crown 206539 Obtained from a hardwares store (Lowes).

MakerGear M2 MakerGear This printer is more costly than inexpensive FDM printers obtainable on Amazon or other sites, but it is engineered for more consistent performance.

MakerGear M2 Dual MakerGear This model printer is no longer available for purchase. It has been replaced with a new model that has independent dual extruders.

Multi-Surface 1.88-in Painters Tape 3M 116480 Obtained from a hardwares store (Lowes).

PETG: Pink 1.75 mm filament spool, 1 kg Amazon Obtained from reseller (B&H and/or Amazon). No longer available from this company.

PETG: White 1.75 mm filament spool, 1 kg Amazon Obtained from reseller (B&H and/or Amazon). No longer available from this company.

PLA: Black 1.75 mm filament spool, 2 lb MakerBot MP05775 Obtained from reseller (B&H and/or Amazon).

PLA: Cool Gray 1.75 mm filament spool, 2 lb MakerBot MP05784 Obtained from reseller (B&H and/or Amazon).

PLA: White 1.75 mm filament spool, 2 lb MakerBot MP05780 Obtained from reseller (B&H and/or Amazon).

POLYIMIDE TAPE (2" ROLL) MakerGear Provided with the printer from MakerGear, though obtainable from a variety of sources.

Simplify3D Simplify3D Slicer softward used in prints. This software can be purchased from the company, or it can be purchased from MakerGear and other 3D printer makers.

Table of Materials Click here to access/download;Table of
Materials;Interactive3DModels_Materials_New.xlsx
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This printer is more costly than inexpensive FDM printers obtainable on Amazon or other sites, but it is engineered for more consistent performance.

This model printer is no longer available for purchase. It has been replaced with a new model that has independent dual extruders.

Obtained from reseller (B&H and/or Amazon). No longer available from this company.

Obtained from reseller (B&H and/or Amazon). No longer available from this company.

Provided with the printer from MakerGear, though obtainable from a variety of sources.

Slicer softward used in prints. This software can be purchased from the company, or it can be purchased from MakerGear and other 3D printer makers.
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Editorial Comments: 

• Please take this opportunity to thoroughly proofread the manuscript to 
ensure that there are no spelling or grammatical errors. 

We	have	made	an	effort	to	address	poten0al	spelling	and	grammar	issues	with	this	
revision.		

• Protocol Detail: Please note that your protocol will be used to 
generate the script for the video, and must contain everything that you 
would like shown in the video. Please add more specific details (e.g. 
button clicks for software actions, numerical values for settings, etc) 
to your protocol steps. There should be enough detail in each step to 
supplement the actions seen in the video so that viewers can easily 
replicate the protocol. 
1) Section 1: Please specify all button clicks and menu selections for 
all software steps. 
2) 3.3: Mention sand paper grit and buffer wheel speed. 

Further	protocol	details	have	been	provided,	this	with	a	focus	on	using	the	Simplify3D	
4.1.2	soCware.	While	we	did	not	strongly	highlight	the	use	of	this	specific	soCware	in	
the	manuscript	text,	we	agree	that	a	very	specific	case	in	the	manuscript	could	be	
beneficial	to	readers.	We	also	provide	more	specific	protocol	details	for	ac0vi0es	that	we	
originally	deemed	general,	this	with	some	descrip0ons	of	mo0va0ons.	Highlighted	
excerpts	of	several	of	these	changes	are	as	follows,	though	there	are	more	such	changes	
in	the	revised	manuscript.	They	hopefully	provide	even	clearer	guidance	to	readers/
viewers:	

“…with	specific	considera0ons	given	for	representa0ve	models	shown	with	the	
Simplify3D	4.1.2	soCware	and	MakerGear	M2	FDM	3D	printers.	Dedicated	manufacturer	
direc0ons…”	

“1.2	 Import	one	of	the	C_atom_sp3,	H_atom,	or	C-C_bond	files	into	your	slicer	
program.	Use	millimeter	format	for	the	units	if	an	op0on	is	available.	In	Simplify3D,	
either	click	the	"Import"	buVon	of	the	"Models"	panel	of	the	main	window	or	select	the	
"Import	Models"	command	from	the	under	the	"File"	pulldown	menu.	Select	the	
appropriate	model	file	from	the	resul0ng	file	browser.”	

“1.3	 Scale	the	imported	model	to	the	desired	size.	In	Simplify3D,	double-click	either	
the	graphical	model	in	the	main	display	or	by	double-click	the	listed	model	in	the	
"Models"	panel	of	the	main	window.	This	ac0on	opens	a	model	edi0ng	panel	that	
enables	transla0on,	rota0on,	and	scaling	of	the	target	model.	Representa0ve	models	are	
presented	for	50%,	100%,	200%,	and	320%	scale	for	all	interconnec0ng	parts.”	

“1.4	 Duplicate	models	to	generate	an	array	of	models	as	desired	by	selec0ng	the	
"Duplicate	Models"	op0on	from	the	"Edit"	menu	of	Simplify3D	and	entering	the	number	
of	model	parts	in	the	resul0ng	dialog	box.	Arrange	the	model(s)	near	the	center	of	the	



build	pla`orm	by	clicking	the	"Center	and	Arrange"	buVon	in	the	"Models"	panel	of	the	
main	window,	or	by	selec0ng	the	"Center	and	Arrange"	op0on	under	the	"Edit"	
pulldown	menu.	See	Figure	1	for	an	example	printed	arrangement	of	six	C_atom_sp3	
models	printed	with	PLA	(polylac0c	acid).”	

• Protocol Numbering: Please adjust the numbering of your protocol 
section to follow JoVE’s instructions for authors, 1. should be followed 
by 1.1. and then 1.1.1. if necessary and all steps should be lined up at 
the left margin with no indentations. There must also be a one-line 
space between each protocol step. 

We	have	iden0fied	and	corrected	devia0ons	from	the	JoVE	instruc0ons	for	protocol	
numbering	and	display.	This	included	correc0ng	a	missing	blank	space	between	two	
protocol	items	and	a	refinement	of	numbering	categoriza0on	for	specific	protocol	
ac0ons.	

• Protocol Highlight: The highlighted steps should form a cohesive 
narrative, that is, there must be a logical flow from one highlighted 
step to the next. 

For	the	protocol,	we	have	highlighted	the	main	numbered	steps	and	taken	care	to	
ensure	that	the	protocol	presenta0on	will	be	cohesive	from	a	video	recorded	standpoint	
with	an	example	3D	print.	Such	highligh0ng	has	been	extended	to	include	the	main	
protocol	sec0on	numbers/headers	as	recommended	in	the	Instruc0ons	for	Authors.	
Given	JoVE’s	complementary	manuscript	+	video	communica0on.	We	have	highlighted	3	
sec0ons	of	the	Representa0ve	Results	to	emphasize	the	interac0vity	of	the	resul0ng	
models.	While	not	part	of	the	Protocol	sec0on,	showing	video	of	such	interac0on	with	
resul0ng	models	will	enhance	the	narra0ve	by	drawing	connec0ons	to	molecular	
conformer	sampling	and	the	accessible	phase	space	of	the	molecules.	

• Discussion: JoVE articles are focused on the methods and the protocol, 
thus the discussion should be similarly focused. Please ensure that the 
discussion covers the following in detail and in paragraph form (3-6 
paragraphs): 1) modifications and troubleshooting, 2) limitations of the 
technique, 3) significance with respect to existing methods, 4) future 
applications and 5) critical steps within the protocol. 

We	have	enhanced	the	Discussion	to	beVer	draw	recommended	connec0ons	with	the	
protocol.	



Reviewer #1: 

In the video article, the authors describe some molecular model 
components which can be printed by a FDM 3D printer and used to create 
molecular models of saturated hydrocarbons. This method is not new, 
since it has been reported in many other protocols and publications. 
Although the novelty is not mandatory for JOVE, in my opinion, the 
efficacy of the protocol needs to be emphasized especially in sections 3 
and 4. 
Looking on JOVE website, I found a video that is quite similar to the 
initial part of the protocol which authors would like to make (chapters 
4 and 5). 
https://www.jove.com/video/55427/3d-printing-of-biomolecular-models-for-
research-and-pedagogy 
Said this, even if the "Preparation of model files for 3D printing" 
section and the "Preparation of the printer for printing of parts" 
section will be repeated, the third part of the manuscript deals with 
the assembly of the model structures and the "representative results" 
will be focused on the visualization of the properties of the 
cyclohexane structure. These two aspects have not been visualized so 
far, and I think that a video visualization of the interconversion 
between cyclohexane boat and chair conformers represents a useful 
novelty for teaching purpose. 
My only suggestion during the realization of the video is to dedicate 
more emphasis on 3rd and 4th section with respect to sections 1 and 2. 

We	appreciate	the	reviewer’s	emphasis	on	originality	and	their	efforts	to	frame	the	
presented	work	in	context	with	exis0ng	literature	efforts.	We	also	feel	the	video	the	
reviewer	discovered	is	relevant	to	the	current	effort,	which	is	why	that	par0cular	JoVE	
publica0on	was	similarly	discoverable	by	looking	at	the	cited	references	our	manuscript.	
This	earlier	published	effort	focused	on	crea0ng	sta0c	printable	representa0ons	from	
PDB	models	of	biomolecular	structure	files.	We	have	taken	care	to	focus	more	on	the	
prac0cal	considera0ons	for	reliable	prin0ng	of	dynamic	and	interac0ve	molecular	
structures,	this	with	commodity	3D	printers.	This	is	likely	why	the	reviewer	recognizes	
the	value	added	from	the	laVer	sec0ons	of	our	manuscript.	

We	strenuously	agree	with	the	reviewer	that	highligh0ng	of	a	dynamic	applica0on	is	a	
cri0cal	aspect	of	this	manuscript.	JoVE	is	one	of	the	few	journals	that	directly	integrates	
video	in	a	scien0fic	report,	and	this	provides	an	opportunity	to	communicate	mo0on	in	
ways	that	are	not	possible	with	tradi0onal	scien0fic	journals.	While	we	were	instructed	
by	the	JoVE	Editorial	Staff	to	expand	on	the	early	por0on	of	the	protocol	with	addi0onal	
details,	we	have	responded	in	a	way	that	emphasizes	the	importance	of	the	dynamical	
aspects	of	constructed	3D	molecular	models.	

The text of the manuscript is very clear and no modification is 
required, I think that the manuscript can be accepted in its form. Some 
important references are missing: 

https://www.jove.com/video/55427/3d-printing-of-biomolecular-models-for-research-and-pedagogy
https://www.jove.com/video/55427/3d-printing-of-biomolecular-models-for-research-and-pedagogy


1. J. Chem. Educ. 2015, 92, 1398-1401. 
2. J. Chem. Educ. 2016, 93, 1586-1590. 
3. J. Chem. Educ. 2017, 95, 88-96. 
4. J. Chem. Educ. 2017, 94, 886-891. 
5. J. Chem. Educ. 2017, 94, 964-969. 
6. J. Chem. Educ. 2018, 95, 1607-1611 
7. Chemistry Teacher International 2019: doi 10.1515/cti-2019-0005 

We	thank	the	reviewer	for	the	sugges0on	of	addi0onal	references.	Some	of	these	are	
already	cited	but	others	do	expand	on	the	scope	of	the	field	of	“molecules	and	3D	
prin0ng”.	It	is	beVer	to	consider	more	efforts	to	highlight	relevant	context,	so	we	have	
included	many	of	these	references	in	the	revised	manuscript.	

Reviewer #2: 

Manuscript Summary: 
The authors present a method for 3D-printing molecular model systems 
with improved functionality over previously 3d-printed molecular models, 
in that the models can be adjusted to show various steroisomers. They 
can also make these models in various sizes, which could be helpful for 
classroom use (as you could print huge models for everyone to see). The 
paper is thorough and the figures are well made. The procedure may be of 
use to some educators who want to bring 3d-printing to their classroom 
and promote tactile learning strategies, or possibly a researcher who 
wants to display a molecule of interest. I recommend this manuscript to 
be published in JoVE, as I believe it would be useful for many people 
(teachers) unfamiliar with 3D-printing to be able to approach this 
project and bring it into their classroom. 

We	appreciate	the	reviewer’s	summary	and	opinion	on	the	relevance	of	this	work.	The	
reviewer	has	highlighted	a	key	aim	of	this	work,	helping	encourage	researchers	and	
educators	to	make	more	regular	use	of	3D	prin0ng.	As	discussed	in	response	to	another	
reviewers	comments,	JoVE	provides	a	unique	pathway	for	aiding	this	effort.	

Major Concerns: 
Penny et al (Journal of Chemical Education (2017), 94 (9),) published on 
pretty much this same method, so have several others in the Journal of 
Chemical Education (Dean et al Journal of Chemical Education (2016), 93 
(9),). (Fourches, Denis; Feducia, Jeremiah. Journal of Chemical 
Education (2019), 96) ) 
This needs to be cited and discussed. Mention the benefits that these 
researchers found on using 3D-printed models in the classroom. compare 
your models to theirs, if appropriate. 



We	already	list	and	include	the	Penny	et	al.	work	in	the	manuscript,	and	we	thank	the	
reviewer	for	men0oning	other	works	that	illustrate	the	impact	that	3D	printed	molecular	
structures	can	have	in	pedagogy.		We	have	included	extra	references	in	the	manuscript	
introduc0on.	To	draw	further	dis0nc0on	of	these	efforts	from	our	presented	work,	we	
further	adjusted	wording	in	the	discussion	to	highlight	the	dynamical	and	interac0ve	
quali0es	of	the	models	presented	in	this	work.	

Reviewer #3: 

Manuscript Summary: 
The authors describe a procedure for printing 3D molecular models of 
hydrocarbons. They provide printer files for carbon atoms, hydrogen 
atoms, and bonds that can be assembled into any saturated alkane. The 
abstract provides a thorough description of the manuscript. The title 
could use a few more words describing the resulting models, since the 
models are limited to sp3-hybridized organic molecules and won't be 
useful to a reader hoping to use them to teach VSEPR theory, for 
example. 

The authors eloquently situate this work in the historical context of 
molecular model-building. It is easy to think of molecular models as a 
tool for beginners. The reminder that they were the basis of such 
important breakthroughs as Pauling's work and the elucidation of the 
structure of DNA is worthwhile. I think there is value in pointing this 
out to our students. The authors are careful to acknowledge that these 
models are not designed to provide novel structural insight, as is 
appropriate. 

The fact that these models can simulate the variation in barriers 
between different conformational changes is particularly impressive. 
Molecular models tend to be either static of floppy. The added tactile 
feedback the authors report that these models provide should be a 
valuable addition to the toolkit teachers can give students just 
beginning to develop their intuition about molecular behavior. 

The manuscript lists all of the required materials. The steps are 
detailed and clear. I have a few suggestions for additions and changes 
in emphasis that I describe below. 

Learning to produce useful 3D prints comes with a steep learning curve. 
The authors have addressed many of the most important issues that arise. 
They provide details about how to arrange models on the build plate 
(orientation can have a large effect on print quality) and what settings 
to use (infill percentage is a guessing game to beginners). They discuss 
how the models can be scaled. This is a particulary important issue that 
I had to learn though much trial and error because carefully calibrated 
gaps between snap-together parts behave differently at different 
scalings. 



We	thank	the	reviewer	for	providing	this	detailed	summary.	They	are	simultaneously	
demonstra0ng	their	exper0se	and	highligh0ng	aspects	of	the	manuscript	that	we	were	
hoping	to	effec0vely	communicate.	3D	prin0ng	is	a	bit	of	a	guessing	game	when	it	comes	
to	finding	what	reproducibly	works,	so	our	aim	through	JoVE	is	to	poten0ally	provide	a	
posi0ve	star0ng	point	for	beginners,	as	well	as	some	shared	experiences	for	those	
experienced	with	the	struggles	in	achieving	a	quality	finalized	print.	

Minor Concerns: 
1.3.2. The authors state that rafts are not necessary at sizes above 
100%. This may not be true for all printers. In my experience with a 
Makerbot Desktop (PLA on unheated bed), a raft is essential for all 
prints because the thicker layer of resin adheres to the painters tape 
in a way that the thinner print layers seem incapable of. 

We	thank	the	reviewer	for	this	comment.	The	first	layer	will	make	or	break	a	3D	print.	
We	were	careful	to	state	that	a	raC	“should	not	be	necessary”	as	it	isn’t	from	our	
experience,	though	this	requires	a	well	adhered	first	layer.	We	have	modified	the	text	to	
emphasize	that	raCs	are	generally	useful.	We	also	emphasized	“First	Layer	Sejngs”	in	
the	protocol.	Excerpts	from	these	changes	are	below.	

“1.3.2		Ac0vate	a	raC	or	brim	structure	for	100%	and	smaller	scale	models.	Such	
structures	should	not	be	necessary	for	most	larger	models	as	the	flat	base	will	have	
sufficient	contact	with	the	bed	surface	to	remain	fixed	in	place.	RaCs	help	provide	a	well-
adhered	first	layer	for	a	3D	print,	so	if	there	are	any	difficul0es	in	the	stability	of	the	first	
printed	layer	at	any	scale,	ac0va0ng	a	raC	structure	could	lead	to	more	successful	prints	
at	the	expense	of	the	material	needed	for	the	raC	structure.”	

and	

“1.5.4		Set	the	"First	Layer	Speed"	to	a	value	between	25-50%	in	the	"Layer"	tab	of	the	
process	sejngs.	A	slowly	printed	first	layer	will	improve	adhesion	to	the	print	bed	and	
will	result	in	more	successful	overall	3D	prints.”	

1.5.6. The authors describe slicing as a separate procedure. The 
Makerbot software, which many viewers may be using, doesn't emphasize 
the distinction between slicing and "preparing to print". The authors 
may want to point out that some all-in-one software packages handle this 
step internally. 

We	thank	the	reviewer	for	this	comment.	We	have	pointed	out	this	dis0nc0on	as	part	of	
the	Editorial	staff	recommenda0ons	for	specific	prin0ng	soCware	ac0ons	in	the	protocol.	



3.3.3. The authors describe an acetone dip polish, and later mention the 
problem that arises when dipping parts with gaps. I wonder if the 
authors have tried an acetone vapor polish instead. It might allow the 
imperfect parts to be polished. (I have only printed with PLA, and 
haven't tried it myself, so this just a suggestion.) 

The	reviewer	is	correct	to	point	out	vapor	polishing	as	a	strategy	for	finishing.	It	is	a	bit	
slower	and	comes	with	the	same	cau0ons	as	liquid	acetone	processing.	We	have	
modified	the	text	to	include	vapor	polishing	cau0ons.	The	reference	to	it	could	lead	a	
reader/viewer	to	explore	it	if	it	if	they	have	the	means	and	appropriate	environment.	

“CAUTION:	Acetone	is	flammable	and	should	be	applied	sparingly	in	a	fume	hood	or	very	
well-ven0lated	area.	ABS	dissolves	in	acetone,	so	parts	with	layer	separa0on	defects	due	
to	poor	annealing	should	not	be	treated	with	liquid	acetone.	Acetone	will	enter	models	
through	such	defects	and	dissolve	the	model	infill	(Figure	3C).	Polishing	with	acetone	
vapor	is	a	slower	process	that	will	result	in	a	similar	effect,	though	safety	precau0ons	
should	be	taken	given	the	flammability	of	acetone.”	

My last concern is regarding the included print files. Producing models 
that will print well and accomplish an intended goal presents a very 
large learning curve to a new practitioner -- much larger than learning 
to operate the printer. I understand that preparing models is beyond the 
scope of this submission, but the fact that the set of models can only 
be used to make saturated hydrocarbons is quite limiting. I also 
understand that producing models of doubly-bonded molecules that 
demonstrate the rotation barriers in the way these do is likely to be 
significantly more difficult. But, I think it would be nice to at least 
provide for the existence of heteroatoms. At a minimum, the authors 
could suggest printing carbon atoms in other colors to represent 
nitrogen, oxygen, and halogens. It would be a nice addition to provide 
models for those elements with the appropriate valence. Or, as an 
alternative, they could include a variation of the bond model that only 
connects on one end, which could be used like the "nubs" that some 
molecular modelling software uses to represent lone pairs. 

We	very	much	agree	with	the	reviewer	on	the	point	of	the	limi0ng	aspect	of	sp3	
hybridized	organic	compounds.	We	noted	that	these	parts	are	part	of	a	larger	kit	that	
(yes)	has	different	atom	that	are	sized	according	to	Bondi	radii,	hybridized	structures,	
and	dual-extruder	lone-pair	structures.	These	kits	are	used	for	demonstra0ons	in	
beginning	General	Chemistry	courses	at	Oklahoma	State	University	to	aid	in	teaching	of	
VESPR	theory,	and	we	print	expanded	kits	with	these	structures	to	give	to	lab	visitors	as	
part	of	our	chemical	outreach	ac0vi0es.	The	presenta0on	of	these	details	are,	however,	
a	bit	outside	the	scope	of	the	present	study.	



To	accommodate	the	reviewer’s	concerns,	we	have	expanded	sec0ons	of	the	text	to	
highlight	the	expandability	of	these	models	and	how	one	can	restrict	rota0on	about	
connec0on	points	with	atom	model	adjustments.	

“NOTE:	Rota0on	about	a	connected	bond	is	a	desired	feature	for	the	provided	parts	and	
models.	Locking	rota0on	requires	an	atom	model	(an	sp2	hybridized	carbon,	for	
example)	with	a	fixed	structure	in	the	connec0on	socket	that	inserts	between	the	
spacings	of	the	tabs	on	the	end	of	the	bond	model.“	

“…More	quan0ta0ve	insight	along	these	lines	requires	more	specific	detail	than	the	
considera0ons	taken	in	building	these	model	parts,	but	these	models	and	
recommenda0ons	provide	a	founda0on	for	general	interac0ve	physical	inves0ga0on	of	
molecular	systems.	These	models	are	an	extension	of	3D	printable	model	kits	we	have	
been	producing	for	research	and	outreach	ac0vi0es	for	several	years	prior	to	this	report,	
and	addi0onal	component	parts	that	are	compa0ble	with	both	these	models	and	the	
described	protocol	are	available	from	the	authors	to	enable	more	diverse	bonding	
arrangements	and	dynamical	ac0on.“	

Reviewer #4:  

Manuscript Summary: 
This paper reports on the development of a protocol for creating/
assembling molecular models using individual atom/bond pieces built 
using 3D printers. The manuscript is well written, clear, concise, and 
is of relevance for Jove and probably a relatively large audience in the 
research/teaching community. The reviewer appreciated that all technical 
aspects of the 3D printing process are covered (machines, filaments, 
temperatures, etc.) as well as the fact that all STL files ensuring the 
reproducibility/usability of this protocol are available in the Supp 
Material. Therefore I think this paper could be accepted for 
publication. 

Major Concerns: 
None 

Minor Concerns: 
I would suggest the authors to add one Figure representing their 
protocol (pages 2-4) as a general workflow/diagram. It would be very 
helpful for the readers I think. 

We	thank	the	reviewer	for	these	comments.	To	address	their	concern,	we	have	included	
references	that	contain	similar	flow	charts.	Addi0onally,	JoVE	has	an	integrated	video	
component	that	is	presented	alongside	the	manuscript,	and	a	flow	diagram	would	
strengthen	the	presenta0on	of	this	anima0on/video.	We	will	work	to	incorporate	this	in	
the	video.



HF/6-31G(d) B3LYP/6-311+G(2d,p)

G: Chair / Hartree -234.052478 -235.809299

G: Twist-Boat / Hartree -234.042642 -235.798439

G: Boat / Hartree -234.041642 -235.797169

G: 4 C Coplanar / Hartree -234.035735 -235.791282

G: Chair / kcal mol-1 -146868.6321 -147971.0426

G: Twist-Boat / kcal mol-1 -146862.46 -147964.2279

G: Boat / kcal mol-1 -146861.8325 -147963.4309

G: 4 C Coplanar / kcal mol-1 -146858.1258 -147959.7368

∆G: Chair / kcal mol-1 0.00 0.00

∆G: Twist-Boat / kcal mol-1 6.17 6.81

∆G: Boat / kcal mol-1 6.80 7.61

∆G: 4 C Coplanar / kcal mol-1 10.51 11.31
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